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Chapter 1 Overview 
 

1.1  Brief Function 

ThinkDraw is a set of powerful programming 

software especially designed for programmable 

touch screen, with easy-to-use features and 

strong adaptability. 

It supports a variety of photo formats, with 

highest resolution up to 1024x600, providing with 

multiple buttons and page property configuration, 

helping you to design a novel and fashionable 

touch screen interface. 

 

1.2  Running Environment 

Operation systems supported: 

• Windows200 (Service Pack3 or greater) 

 

• Windows XP Professional (Service Pack1 or 

greater) 

 

• Windows7 Flagship  

 

PC Requirement: 

CD-ROM 

PC mouse or other positioning hardware 

 

1.3  Format Supported 

Supported types of touch screen 

• Wifi-G3  Wifi3.0 Wireless programmable 

remote controller 

 

• Wifi-G5  Wifi 5.7-inch Wireless programmable 

touch screen 

 

• Wifi-G7  Wifi 7.0-inch Wireless programmable 

touch screen 

 

• Wifi-G8  Wifi 8.9-inch Wireless programmable 

touch screen 

 

 

 

• LAN-G10 Wifi10.4-inch Wireless programmable 

touch screen 

 

• LAN-G12 Wifi12-inch Wireless programmable 

touch screen  

 

• LAN-G15 Wifi15.1-inch Wireless programmable 

touch screen   
Supported Resolutions 
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Chapter 2 CREATOR Language rule 
 

2.1  Interface Introduction 

The working area of ThinkDraw comprises of the following parts: 

 

 

2.2  Tool Bar 

In ThinkDraw, the tool bar is easy to use, as 

with multiple tool menus for realizing different 

functions. Right-click any position in the tool bar 

to show or hide the displaying frame of menu, so 

as to the menu that you wish to show or hide. Tool 

menu can be dragged freely, as long as you move 

the mouse cursor to the far left of tool menu 

where it will become a moving cursor. Click and 

hold left button to drag the tool menu selected. 

More your cursor onto any button on the tool 

menu, function description will be shown 

automatically. 

Move any tool menu by dragging it to the left of 

navigation window in working area, the menu will 

be automatically placed on the left of the  

 

 

navigation window. 

 

Tool Bar 

 

 

 

 

 

 

 

 

 

 

 

Design preview window 

 

Navigation 

window in 

working area 

Status management window 
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Tool Menu 

 

2.3  Design preview window 

Design preview window is for displaying all 

pages/sub-pages created, in where you may 

freely add key in any size. By modifying the 

property of page/sub-page, it may be shown in 

design preview window in where 

pages/sub-pages in any number can be shown. 

By selecting the display menu on top of the  

window, you may right-click the pull-down list from 

far right to select you desired pages/sub-pages, 

or click on the pull-down list on the far right in the 

menu. 

 

Design preview window 

 

 

 

 

2.4 Navigation window of working 

zone 

    Navigation window of working zone displays 

all pages/sub-pages in opened project. In this 

zone, you may preview, edit, add, copy, delete 

and cut all pages/sub-pages. 

 

 

2.4.1 Page label 

Click on the below the navigator, 

you can see page label of the navigator, where 

displays all pages/sub-pages of all open projects. 

Each project is displayed in the form of file folder. 

The page/sub-pages in the folder will break up 

into files in subdirectory. 

 



                                                                          

 
CREATOR CHINA  2010-08   WWW.CREATOR1997.COM 

              4 User’s Manual of ThinkDraw Programming software 
 
 

2.4.2 Use navigator to open 

page/sub-page 

    In the navigator of working zone, double-click 

on the selected page/sub-page to open it in the 

navigation window. 

 

2.5  Property control window 

Property control window is on the right of 

software working zone (or dragging to display at 

any position), for displaying and editing page, 

sub-page and the property of button, as well as 

the status and information relationship within all  

elements in the project. 

Select View>Properties (or click on button on 

tool bar) to display property control window. On 

top of the window, you may see page, sub-page 

and button pull-down list, click on relevant button 

to change the property. 

Property control window comprises of 3 property 

lists: 

* General label 

* Programming label 

* Status label 

 

 

 

2.5.1 Property control window --- 

general label 

The general label on property control window 

is for configuring and editing the general 

properties of all pages, sub-pages and buttons. 

On general label, all properties are display in 

tables. The basic properties of object will be listed, 

such as name, size and coordinate. 

 

 

2.5.2 Property control 

window---programming label 

click on programming label to see or edit the 

properties of selected button relevant to 

programming. These information will be listed in a 

table. Now the programming property is mainly of 

the Join Number of button.  
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2.5.3 Property control window---status 

label  

click on status label to see or edit all relevant 

status information of the selected button. Status 

information will be listed in table. Status label 

comprise of a table with each status property of 

selected button. To edit the property of selected 

button, just need to click and modify the value on 

the right of the property option.  

 

 

2.6  Status management window 

Status management window is for viewing 

button status. Generally, there are 2 status for 

common buttons—inactive or active, while 

multi-status button comprise of many status, one 

of which is inactive, while active status also 

comprises of many kinds. In status management 

window, you may see all status of the button, 

including those active or inactive. Click on 

view>state manager to open or close status 

management window. 

 

In property control window, you may modify 

the status property of page, sub-page or button. 

In this window, you can view the modified status 

at any moment, especially multi-status button and 

all active status. 

 

2.6.1  Status management breakdown 

Right-click mouse at any place of the status 

management window to see a selection table. 

And then you may open, close or hide 

management window.  

* Use Ctrl+click to select your desired button 

status 

* Use Shift+click to select a line of button status 

(select and click both ends of the selected status 

line). 

 

2.7 Use docking window 

In ThinkDraw, all windows support docking 

randomly in application software window. And 

they will automatically be in alignment at the top, 

bottom, left or right of application window. To 

fasten/move a window, you just need to 

double-click the window title bar. The followings 

windows are all for docking in ThinkDraw: 

* Design View 
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* Properties Control 

* Workspace Navigator 

* State Manager 

* Button Preview 

* Magnifier Window 

 

 

2.7.1 Moving and resizing the docking 

windows 

In ThinkDraw, all windows (design preview, 

property control, working zone navigator, status 

management) can be docked. 

* Click on the title bar of window to drag and move 

windows 

 

* Drag the windows to the edge of application 

window, the windows will automatically be in 

alignment along the edge of application window. 

 

* To extend the window, click on the horizontal or 

vertical edge of the window, and drag it.  

 

* To resize the window, click on one of the four 

corners of the window, drag and adjust it when 

seeing double-arrow icon.  

 

2.7.2 Auto-hiding window 

Each window(design preview, property 

control, working zone navigator, status 

management) can be opened/ hidden by 

choosing the options in menu. Choose one of the 

windows in the menu to hide it. 
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Chapter 3 Software Engineering Files 
 

When saving a newly-created touch screen 

engineering file, the system will auto-save it into 

the directory of the file saved last time, unless you 

select to save it in other directory. 

Each page/sub-page is not limited in the 

length of name. In the same touch screen 

engineering file, the name of page/sub-page can 

only be unique. The system will pop up an 

alarming box when the name is duplicated, and 

request to re-input the name. 

 

3.1  Dragging and placing 

When ThinkDraw programming software is 

opened, you may directly drag touch screen file 

(*.TPG) into the working zone, then the file will be 

auto-opened in the programming software. 

 

3.2  Use ThinkDraw to create a 

new engineering file 

ThinkDraw programming software provides 

with a wizard for quickly creating touch screen 

engineering file. Use this wizard can create such 

file very easily.  

 

3.3 Use the wizard for creating 

new project  

ThinkDraw has a wizard for creating new 

project, helping you to quickly set up a new 

project. Click on File>New or click the button on 

tool bar. 

The wizard is very simple and straightforward. 

You just need to fill the necessary content into the 

wizard, and then click on NEXT button to move to 

the next dialog box. In the last dialog box, you just 

need to click on the FINISH button to close the  

 

wizard. At this moment, the new project has been 

created. The project provides with a page, on 

which user may add page, sub-page and button 

at any moment.  

 

Wizard for creating new project is made up of 

3 dialog boxes: 

1. Dialog box 1 for filling the basic information of 

new project. 

Job Name   Name of new project 

Panel Type   Click the pull-down list to select 

you desired touch screen type. 

Resolution   The resolution of selected touch 

screen has been fixed according to the touch                 

screen model  

Use System  Click on the box before project 

name to create basic information of the project 

Generated File name 

 

2. Dialog box 2 comprises of basic system file 

information. If “Use System Generated File 

Name” hasn’t been selected in dialog box 1, it will 

be passed off in dialog box 2. 

Designer   Input the name of project 

designer 

Dealer ID   Input the ID code of dealer 

Sales Order   Input sales order code 

Purchase Order Input purchase order code 

Revision   Input version information 

Job Comments  Input project-relevant 

information 

 

Fill in the necessary information, and click on 

NEXT to next step 

 

3. The last dialog box of the wizard is for creating 

initial touch screen page of the project. 

Name    Input page name 

Colors(page)  Click on color selection button 

to open color dialog box, and then select 
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Background  background color and text color. 

and text) 

Font    Click on text pull-down list and 

select your desired font type 

Font Size   Click on the pull-down list 

and select the desired font size 

 

Fill in the necessary information, and click on 

FINISH to exit the wizard. 

 

3.4 Configure project property 

Select File>Project Properties to open the 

dialog box, which comprises of a variety of lists 

for viewing and editing the properties of touch 

screen project and object. For some touch screen 

types, property options are not active.  

Panel setup information tab includes: startup, 

wakeup and sleep strings, power up page and 

feedback blink rate. 

 

Project property dialog box---panel setup 

information 

Use the options in panel setup information to 

view and edit the configuration information of 

project file. The options on the page include: 

 

Refresh Frequency   select the refresh 

frequency in the pull-down list 

 

Panel Strings   Input character strings into 

the options of startup, wakeup and sleep, so     

                      the strings will be 

displayed in corresponding touch screens. 

 

Power up page   Click on the pull-down 

list to show all pages, click on one of them to set it           

     as the homepage of touch 

screen 

 

Power up popups  Display the read-only 

information on screen 

 

 

Inactivity page   Click on the pull-down 

triangle to select screen saver page 

 

Feedback blink rate  Use this option to 

configure the frequency of feedback blink 

 

3.5 Configure a page when power 

on 

Touch on the screen when it’s re-powered on, 

use the “panel setup information” in project 

property dialog box to select one of pages in 

“power up page” pull-down list. 

1. Select File>Project Properties to open project 

property dialog box. 

2. In Panel Setup Information page, click on the 

pull-down list in “power up page” to show all 

pages in project file. 

3. In pull-down list on the page, select a page to 

be shown when power on.  

 

3.6  Focus of editing 

working zone navigator is located at the left 

of the software interface, for opening the 

page/sub-page of project file, and viewing/editing 

the inter-relationship among all pages.  

 

Focus of editing---page 

 

Focus of editing on the button is surrounded by 8 

red dots with yellow frame, as the following 

pictures: 



                                                                          

 
CREATOR CHINA  2010-08   WWW.CREATOR1997.COM 

              9 User’s Manual of ThinkDraw Programming software 
 
 

 

Focus of editing---button 

 

3.7 Use working zone navigator 

working zone navigator is located at the left of the 

software interface, for opening the page/sub-page 

of project file, and viewing/editing the 

inter-relationship among all pages.  

 

3.7.1 Working zone navigator---page 

label 

click on the pages label under working zone 

navigator window, you may view all 

pages/sub-pages contained in each project. 

Each project is shown in the form of folder, with 

icon in different colors 

 
Working zone navigator---page label 

 

Please note that each project comprises of two 

folders: page and sub-page. Click on “+” mark to 

open sub-directory, or double-click on the folder 

to view the pages and sub-pages in it. 

 

In working zone navigator, pages label has two  

 

panel folders: one is page, the other is sub-page. 

In sub-page folder, you may view extra folders, 

which stands for sub-page groups. 

 

3.7.2 Use working zone navigator to 

open page/sub-page 

Double-click to open page/sub-page in working 

zone navigator, corresponding page/sub-page will 

be opened in design navigator window. 

. 

3.8 Cut, copy and paste 

In ThinkDraw, many ways are available for you to 

cut, copy and paste, significantly improving 

personal working efficiency.  

 

Copy and paste functions are always effective in 

current editing focus (including button, bmp 

button, even personal feature control display). 

The button formed by cutting and pasting will be 

with same property to original button including 

size, position, Join Number, interlock group and 

jumping page etc. 

 

3.9 Edit multiple project files at the 

same time 

ThinkDraw supports editing multiple project files 

at the same time. 

 

3.9.1 Open multiple projects at the same 

time 

* Up to 50 projects to be opened at the same time 

 

* Each project page is with independent label 

when configuring preview window. If over 10 

pages are opened, labels will automatically 

disappear due to short of space. 

 

* You may cut/paste page, sub-pages and buttons 

within projects to save your time. 
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3.9.2 Copy/paste within projects 

ThinkDraw allows user to copy or paste page, 

sub-page and button. With this function, you may 

obviously save your time. 

 

If cutting/pasting the page or sub-page containing 

button, the page will be copied along with all 

buttons. 
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Chapter 4 Software Resource Manager 
 

Select Panel>Resource Manager (or click on 

tool bar button to open it ), in the manager you 

may easily edit and manage image, icon and 

audio. In summary, there are following 4 parts: 

 

Image: easily import and preview all image files, 

support common image formats. 

Dynamic Images Slots: allocate managing icons 

Resource manager has its own tool bar for editing 

image, list, dynamic image and auto file, with the 

following functions available: 

 

Copy, Paste, Cut: these function are mainly for 

moving image files ranging from image label to 

icon label, supporting selecting multiple files at 

one time. Please note that if you copy or paste 

multiple files to clipboard from image label, you 

must at least select icons in the numbers from 

icon labels, so as to paste at all image files. When 

you’re pasting multiple images, if you just select 

one icon, then you can only paste it to the first 

image file.  

 

Delete: select one or multiple files, and click on 

delete key on keyboard to delete the file(s) from 

current project file, but not from the hard disk. 

 

Rename: select a image file and click on rename 

button to open rename dialog box, in which there 

are two options: old file name (read only, 

displaying current file name) and new file name 

(input new file name). Click on OK to finish 

renaming file.  

 

Undo/Redo: In resource manager, you may 

undo/redo all actions. 

 

Import: click on Import button to call dialog box. 

Use the dialog box to select and import images  

 

and audio files to current label. 

 

When any image in supported format (except 

PNG format) is imported into the project, the 

image will be automatically converted into JPGs 

format. So you if import (or paste) a file with the 

same name (or same name but different 

extension name) to an existing file, the software 

will automatically add “copied” before the name. 

Image files in PNGs format have been 

compressed, so they won’t be converted. 

 

New: This item is only used for dynamic image 

label (and replace the button imported from other 

label bar). Click to create dynamic image dialog 

box, use this box to add dynamic images into the 

project. 

 

Export: This item is for exporting one or a variety 

of images to an appointed directory. 

 

List Style: Click downward arrow to open a 

downward list, as follows: 

* Small Icons---display files in small icon in 

multiple columns. 

* Details---display files by size, type or modified 

date. 

* Thumbnails---preview files in small image 

format in every file. 

 

4.1 Resource manager dialog 

box---Image label 

Use the image label bar in resource manager 

dialog box, you may easily import and preview all 

image in the project. You may see the image label 

bar as a library (for example: page, sub-page, 

button and icon in the project) of image files for 

using in the project. 
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Before using the file in the project, import all 

images into image label bar for maintenance, no 

matter the image is used for button or page 

background etc. 

 

4.2  Resource dialog box ---image 

label 

Use the image label bar in resource manager 

dialog box, you may easily preview and manage 

all image files. Once the files has been assigned 

to a position in resource manager, actually it 

becomes an icon. 

All images have to be assigned to a position of 

image label bar before being using for page, 

sub-page or button. Once the image is appointed 

to a position, you may select your desired icon 

from “Icon Slot” item in “States” bar, and not 

necessary to assign the image to a position. 

 

Buttons in image label tool bar are the follows 

l Select All: click and select all icons (1-500), 

program restricts 500 icons in each panel as 

default. To change icon number displayed, modify 

in Panel>Set Maximum Icon Slots. 

l Move: this button is for moving icon. Firstly, 

select the icon to move, press “ctrl” key and click 

the position to move, and then click “move” button 

to move icon. 

l Duplicate: this button is for duplicating icon. 

Firstly select the icon to duplicate. Press “ctrl” key 

and click the position to duplicate, and then click 

“Duplicate” button to duplicate the icon. 

l Swap: swap icon position. Firstly, select two 

icons for swapping, and then click on “swap” 

button. 

l Assign: this button is for assigning selected 

image to target position. 

l Cancel: if one or multiple images have been 

selected, and you click the “Assign” button on 

image label bar, before next step, click on this 

button to cancel the operation of assigning image  

 

position. 

 

4.3  Use of image label 

Before using image in your button or page, this 

image must be imported to the project via 

resource manager dialog box. 

Once the image is imported, you may select your 

desired icon from “Bitmap” item on “States” bar in 

parameters window, and apply it to page, 

sub-page or button. 

Note: The icon for appointed position can be used 

for many times in the project. 

Open Resource manager, select Panel>Resource 

Manager (or click on relevant icon on tool 

bar ). 

 

Import image file into project 

With the following steps: 

1. Select Panel>Resource manager ( or click on 

relevant icon on tool bar ), to open dialog box. 

 

2. Open image label bar. 

 

3. Click on “Import” button to open dialog box. 

 

4. Click on the “overwrite” check box , 

to auto-update any imported images with the 

same name. If this check box has been selected. 

Any time when the imported image has the same 

name as the existing image, the image that 

previously applied in button and page will be 

replaced. 

 

5. Click on “Open” to import image to image label 

bar. 

 

6. Please note the following before importing 

image: 

l When any image in supported format (except  
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PGN) is imported to the project, the image will be 

auto-transformed to JPGs format. If the imported 

(or pasted) image shares the same name with the 

existing image (even with the same name but 

different format), the software will automatically 

add a prefix of “copied from” to the image name.  

 

PNGs format won’t be transformed into JPG 

format, as it’s already a compressed image. 

l The touch screen support dimension up to 

1280x1024. Any imported image with larger size 

will be automatically zoomed out in proportion, so 

the image won’t be distorted.  

 

Assign image to the position of icon 

With the following steps: 

1. Select Panel>Resource Manager (or click on 

tool bar button) to open resource manager dialog 

box. 

 

2. Open image bar. 

 

3. Select one or multiple images (Ctrl + click on 

images one by one, or Shift + click on images one 

by one). 

 

4. Click on “Assign To Slot” to open image label. 

 

5. If there is no image assigned to icon yet (void 

image label bar), click on “Assign” on image bar 

to assign the image to the position of 1st icon. If 

you select multiple images, they will be assigned 

to the selected position. 

 

6. If there are some images in image label bar, 

you have to be carefully to assign the image to 

icon label bar. Use “Overwrite” to select a better 

assigning way. 

 

4.4  Use of Icon label 

With the concept of slot, ThinkDraw adds one 

icon to page, sub-page or button from the  

 

program. 

Once one image is imported to one project, it may 

be assigned to a slot position, and then the image 

can be used in the project as an icon. 

 

Assign image to icon label slot 

With the following steps: 

 

1. Select Ranel>Resource Manager (or click on 

relevant tool bar button ) to open resource 

manager dialog box. 

 

2. Open image label bar, dynamic image label bar, 

image label bar and add in images in relevant 

types. 

 

3. Select one or multiple images (Ctrl + click on 

images one by one, or Shift + click on images one 

by one). 

 

4. Click on “Assign to slot” to open image label 

bar. 

 

5. If the image hasn’t been assigned to icon(void 

image label bar), click on “Assign” on tool bar to 

assign an image to the first icon position. If you 

select multiple images, they will be assigned to 

the initial selected position. 

6. If there have been some icons in icon label bar, 

you must be careful to assign images to icon label 

bar. Use “overwrite” to select a better way of 

assignment.  
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Chapter 5 Page and Sub-page 
 

5.1 Main page 

On the navigation bar in working area in the page, 

you can see all pages including main-pages and 

sub-pages. At the left down corner of the icon, 

there is a green small triangle, indicating the page 

is active. Double-click any page icon to open the 

page. For example: “Meeting room” is a newly 

created project name. “Page 1” is current active 

page. 

 
 

5.1.1 Add a new main page under the 

active project file. 

1. Select Page>Add Page (or click on tool bar 

icon) to open dialog box to add a new main page. 

 

2. In “Name” dialog box, fill in the name of new 

main page (maximum for 50 characters, avoid 

using any irrelevant character). 

 

3. Page background color configuration: 

* click on navigation button (…) to open dialog 

box for color configuration. 

* click to select new color from the list, current 

color is shown at right side. 

 

4. Page text font configuration (apply to page text) 

* click on navigation button (…) to open dialog 

box for color configuration. 

* click to select new color from the list, current 

color is shown at right side. 

 

 

 

5. Font name and size configuration 

 

6.click on “OK” to add a new main page in the 

project, which is shown on the navigation bar in 

working area. 

 

5.1.2 Configure main page property 

use parameter configuration label bar to set up  

 

and edit main page parameters. This window 

comprises of all properties of current active main 

page. 

 

5.1.3 Item General 1 of main page 

property 

* When name is default, the new added main 

page will generally be named “Page1,” “Page2” 

and “Page3”…Or you may modify the name on 

your own. 

 

* Description is for adding the descriptive words 

to the main page. 

 

* Show Effect: to display effect, to configure main 

page displaying effect with the following options: 

---No effect 

---Slide in from top 

---Slide in from bottom 

---Slide in from right 

---Slide in from left 

---Fade in effect 

 

5.1.4 Configure main page status 

property---States item 

Use status label bar to configure main page 

status property, including the following setups. 

 

* Fill Color: click on navigation button to open  
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palette, and then configure the color 

 

* Text Color: configure text font color, click on 

navigation button to open palette, and then 

configure the color. 

 

* Text Effect Color: configure the color effect of 

text 

 

* Bitmap: import the image files to page or button  

 

of current project from resource manager. 

 

* Bitmap Justification: for alignment of images, 

click to open the pull-down dialog box, select 

image alignment way. 

 

* Bitmap X Offsets: image offset in X axis, for 

configuring the coordinate position of image. 

 

* Bitmap Y Offsets: image offset in Y axis, for 

configuring the coordinate position of image. 

 

* Icon Slot: for importing the icon file to page or 

button in current project from resource manager.  

 

* Icon Justification: icon alignment. Click on 

pull-down dialog box, select the way of icon 

alignment. 

 

* Icon X Offsets: icon offset in X axis, for 

configuring the coordinate position of image. 

 

* Icon Y Offsets: icon offset in Y axis, for 

configuring the coordinate position of image. 

 

* Font configuration. Open font configuration 

dialog box. 

 

* Text: open text input dialog box. 

 

* Text Justification: text alignment. Click on 

pull-down dialog box, select the way of text  

 

alignment. 

 

* Text X Offsets: text offset in X axis, for 

configuring the coordinate position of text. 

 

*Text Y Offsets: text offset in Y axis, for 

configuring the coordinate position of text. 

 

* Text effect: open pull-down dialog box to select 

appropriate text effect. 

 

* Word Wrap: automatically move to a new line.  

 

5.1.5 Configure the text in main page 

Directly display text in the page of project, if 

putting text and image together in the page, text 

will be auto-shown on the image. 

Steps of adding text to page: 

 

1. Create a new home page (Panel>Add Page), 

or open an existing home page. 

 

2. Select the home page to add text, click on “Text 

Color” in status property bar, activate text 

navigation button (…), click on navigation button 

to open color configuration dialog box, select your 

color.  

 

3. Click on “Font” in status property bar to activate 

font navigation button (…), click on navigation 

button to open font configuration dialog box, 

select your font. 

 

4. Click on “Text” to open text input dialog box, 

input text and click on “OK”. 

 

5. Click on “Word Wrap” to automatically move to 

a new line.  

 

5.1.6 Configure the image in main page 

In ThinkDraw, you may set the imported image as 

page background. 
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Steps of adding image to sub-page: 

1. Create a new home page (Panel>Page), or 

open an existing sub-page. 

 

2. Select the home page to add image, click on 

“Bitmap” in status property bar to activate image 

navigation button (…). 

 

3. Click on “Browse” button to open to select your 

image. 

 

4. Click on “Bitmap Justification” to open 

pull-down dialog box. Select the way of image 

alignment. If select “Absolute,” you may place the 

image manually. 

 

5.1.7  Configure main page icon 

In ThinkDraw, you may use icon as front image of 

home page in the project. 

 

Steps of adding icon to main page: 

1. Create a new home page (Panel>Page), or 

open an existing sub-page. 

 

2. Select the home page to add icon, click on the 

“Icon Slot” in status property bar to activate text 

navigation button (…). 

 

3. Click on navigation button (…) to open icon 

selection dialog box and select an icon to home 

page. 

 

4. Click on “Icon Justification” to open pull-down 

dialog box, and select the way of icon alignment. 

If select “Absolute,” you may place the icon 

manually.  

 

5.2  Export all pages as images 

Use image export dialog box tool to export all 

pages in current project, and save them as image 

file in general format. 

 

 

1. Select Panel>Export Page Image to open 

image export dialog box. 

 

2. Select the pages and sub-pages to export. 

 

3. In Export Directory column, select the directory 

for saving exported images. 

 

4. Filename Template is a naming template for 

assigned file. Default is project name + page 

name, with the same description in dialog box. $P  

 

is for project name; $p is for page name. 

 

5. In File Format pull-down dialog box, select 

image types to export (JPG, PNG, BMP). If select 

JPG format, you may select the compression 

level. 

 

6.Click on “Export” to finish exporting image. 

 

5.3  Sub-page 

Sub-page shares some configurations with main 

page. For example: they both can place button 

into page. 

 

5.3.1 Add a new sub-page 

1. Select Page>Add Popup Page (or click on tool 

bar icon ) to open sub-page adding dialog box. 

 

2. In “Name” input box, fill in the name of new 

added sub-page (maximum 50 characters, 

avoiding using irrelevant character). 

 

3. In “Border” pull-down box, select a proper 

border type. 

 

4. In “Position” input the left and top coordinates 

(relative to top left corner in the interface) 

 

5. In “Size” column, input sub-page window 
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dimension. 

 

6. In “Page Background Color” column, configure 

sub-page background color. 

 

5.3.2 Use sub-page drawing tool 

1. Select Edit>Popup Draw Tool (or click on tool 

bar icon ) to activate sub-page drawing tool. 

 

2. To add sub-page in active window page, click 

on mouse left key and draw out a box at random 

size for making the page. The minimum size of 

page is with 15 pixels width.  

 

5.3.3 Configure sub-page property 

Use parameters configuration label bar to 

configure and edit the parameters in sub-page. 

This window comprises of all properties of current 

active sub-page. 

 

5.3.4 Item general 1 in sub-page 

property column 

* When name is default, the new added first 

sub-page will generally be named “Popup Page 

1,” “Popup page 2” and “Popup page 3”… or you 

may modify the name on your own. 

 

* Left/top coordinate values: distance between 

sub-page to left top corner of current window, you 

may input a coordinate to locate the sub-page on 

main page. When you’re drawing the sub-page, 

its coordinate will change coordinately.  

 

* Width/Height: configure the width/height of 

sub-page 

* Show Effect: configure the display effect of 

sub-page, with the following options: 

---No effect 

---Slide in from top 

---Slide in from bottom 

---Slide in from right 

---Slide in from left 

 

---Fade in effect 

 

5.3.5 Configure sub-page status 

property---States item 

Use status label bar to configure sub-page status 

property, including the following setups. 

 

* Border Name: select sub-page border frame 

type from pull-down list. 

 

* Border color: configure border color 

 

* Fill Color: fill in color, click on navigation button 

to open palette and configure the color. 

 

* Text Color: configure text font color. Click on 

navigation button to open palette to configure 

color. 

 

* Bitmap: for importing the images from resource 

manager to the button or page in current project. 

 

* Bitmap Justification: image alignment. Click to 

open pull-down dialog box, and then select the 

way of image alignment.  

 

* Bitmap X Offsets: image offset in X axis, for 

configuring the coordinate position of image. 

 

* Bitmap Y Offsets: image offset in Y axis, for 

configuring the coordinate position of image. 

 

* Icon Justification: icon alignment. Click on 

pull-down dialog box, select the way of icon 

alignment. 

 

* Icon X Offsets: icon offset in X axis, for 

configuring the coordinate position of image. 

 

* Icon Y Offsets: icon offset in Y axis, for 

configuring the coordinate position of image. 

 

* Font configuration. Open font configuration 
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dialog box. 

 

* Text: open text input dialog box. 

 

* Text Justification: text alignment. Click on 

pull-down dialog box, select the way of text 

alignment. 

 

* Text X Offsets: text offset in X axis, for 

configuring the coordinate position of text. 

 

* Text Y Offsets: text offset in Y axis, for 

configuring the coordinate position of text. 

 

* Text effect: open pull-down dialog box to select  

appropriate text effect. 

 

* Word Wrap: automatically move to a new line.  

 

5.3.6 Border pattern  

Any time when you create a new page or button, 

you need to appoint border type. If you don’t wish 

to have border in your project, you may select 

“none” in border type options. ThinkDraw 

provides a variety of border types for your choice. 

All of these types can be used in page and button. 

 

5.3.7 Configure the fill-in color of 

sub-page 

Steps of adding fill-in color to sub-page: 

1. Create a new page (Panel>Add Popup Page), 

or open an existing sub-page. 

 

2. Select sub-page, click on “Fill color” in status 

property bar to active text navigation button (…). 

 

3. Click on navigation button to open color 

configuration dialog box, and then select your 

color. 

 

5.3.8 Configure sub-page text 

In the page of project, text can be directly 

displayed. If image and text are placed together in 

 

the page, text will be shown automatically on top 

of the image. 

 

Steps of adding text to page: 

1. Create a new sub-page (Panel>Add Popup 

Page) or open an existing sub-page. 

 

2. Select the sub-page, click on “Text Color” on 

status property bar to activate text navigation 

button (…). Click on navigation button to open 

color configuration dialog box, and then select 

your color. 

 

3. Click on “Font” on status property bar to 

 

activate font navigation button (…). Click on 

navigation button to open font configuration 

dialog box, and then select your font. 

 

4. Click on “Text” to open text input dialog box, 

input text and click on “OK”. 

 

5. Click on “Text Justification” to open pull-down 

dialog box to select the way of text alignment. If  

6. Click on “Word Wrap” to auto-move to next line. 

 

5.3.9 Configure image in sub-page 

In ThinkDraw, you may set an imported image as 

page background. 

 

Steps of adding image to sub-page: 

1. Create a new sub-page (Panel>Add Popup 

Page), or open an existing sub-page. 

 

2. Select the sub-page, click on “Bitmap” in status 

property bar to activate image navigation button 

(…). 

 

3. Click on “Browse” button to open image dialog 

box, and then select your image. 

 

4. Click on “Bitmap Justification” to open 

pull-down dialog box, and then select the way of 
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image alignment. If you select “Absolute,” You 

may place the image manually.  

 

5.3.10 Configure the icon in sub-page. 

In ThinkDraw, you may set an icon as front image 

of page. 

 

Steps of adding icon to sub-page: 

1. Create a new sub-page (Panel>Add Popup 

Page), or open an existing sub-page. 

 

2. Select the sub-page to add icon, click on “Icon 

Slot” in status property bar to activate image 

navigation button (…). 

 

 

3. Click on navigation button (…) to open icon 

selection dialog box, and then select an icon for 

the sub-page. 

 

4. Click on “Icon Justification” to open pull-down 

dialog box, and then select the way of icon 

alignment. If you select “Absolute,” you may place 

the icon manually. 
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Chapter 6 Button Components 
 

6.1 Button types 

ThinkDraw supports 4 button types including 

Button Draw Tool,  Multi-state Button Draw 

Took , Bargraph Draw Tool and Multi-state 

Bargraph Draw Tool , with the following 

instructions: 

 

1. Button Draw Tool 

Button Draw Tool is a routine button for 

dual-status generally, with routine button function 

on touch panel. Using property tool, you may 

customize its border frame pattern, fill-in color, 

button background image, PIP and text.  

 

2. Multi-State Button Draw Tool 

Multi-state Button Draw tool is a button with 

multiple states, for special button function on 

touch panel. Using property tool, you may 

customize its display number, animation effect, 

border frame pattern, fill-in color, button 

background image, PIP and text. 

 

3. Bargraph Draw Tool 

Bargraph Draw Tool is a routine bar with double 

states, for horizontal monitoring and control. The 

adjustable horizontal bar is configured for 

monitoring or adjusting audio output and 

illumination.  

Also, you may customize its border frame pattern, 

fill-in color, button background image, PIP and 

text. 

 

4. Multi-state Bargraph Draw Tool 

Multi-state Bargraph Draw Tool is with multiple 

states for horizontal monitoring and control. The 

adjustable horizontal bar is configured for 

 

 

 

monitoring or adjusting audio output and 

illumination. 

Also, you may customize its number of status 

display, animation effect, border frame pattern,  

fill-in color, button background image, PIP and 

text. 

 

6.2 Create button 

ThinkDraw has 2 simple operations to create 

button: Directly drawing on page, or Copy and 

Paste.  

1. Directly drawing 

Click and select the button type to create from 

tool bar, place the mouse onto page. Hold left key 

to draw up and down or left and right to desired 

button size.  

 

2. Copy and paste 

Click “Select Tool “ tool, move the mouse onto 

page, select and copy one or multiple created 

button, and then paste it onto desired position or 

page.  

 

6.3 Button assistant tool 

With simple creation function only, it is never 

enough to make a delicate, innovated and 

theme-matching button. ThinkDraw software has 

multiple functions for easy button arrangement 

and appearance design, with following detailed 

functions: 
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6.4 Button position and size alignment 

 

   

Align ：  Left, Horizontal 

Center, Right, Top, Vertical 

Center, Bottom 

Use shortcut key to make button alignment in ideal 

design effect.  Whatever size and shape, the buttons 

will lastly be in a line or column. Note the selected 

buttons must be in number of 2 or above 

   
Center Horizontal/Vertical Use this key to make one or multiple buttons in 

horizontal or vertical center 

  

   

Horizontal Spacing （Equal,  
Increase, Decrease, 

Remove） When designing, it is necessary to increase, decrease or 

alternate the spaces within the buttons on page. Use this 

command to control the horizontal distance between 

buttons. 

When selecting three buttons or above, you may adjust 

their horizontal positions to make them equal, increased, 

decreased or alternated.  

If only two buttons are selected, you cannot customize 

the horizontal equal property. Note: all commands are 

executed as making adjustment on the basis of first 

button selected. 

  

  

Vertical Spacing （ Equal, 

Increase, Decrease, Remove）When designing, it is necessary to increase, decrease or alternate the spaces within the buttons on page. Use this 

command to control the vertical distance between 

buttons. 

When selecting three buttons or above, you may adjust 

their vertical positions to make them equal, increased, 

decreased or alternated. 

If only two buttons are selected, you cannot customize 

the vertical equal property. Note: all commands are 

executed as making adjustment on the basis of first 

button selected 

 

    
Send to Front/Send To Back These two commands are for adjusting the overlapping 

sequence of one or multiple buttons on page. Select one 

or multiple buttons, and then place them on the top or 

bottom of buttons. 

   
Shift Up/Shift Down  These two commands are for adjusting the overlapping 

sequence of one or multiple buttons on page. Select one 

or multiple buttons, and then adjust the button to move 

upward or downward one layer 

   
Make Same Width/Height/Size These commands are for adjusting two or above buttons 

with equal height, equal width and equal size. Command 

is executed with adjustment on the basis of first button 
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6.5 Button property configuration 

When a new button is created, you may use 

routine property option card to configure and edit 

it. Each property option card lists the 

configuration types of selected button. Click on 

button to activate the option card, and then 

customize the property of button. 

There are 3 types of property option cards. They 

are General, Programming and States. The 

button types are subject to the option card 

properties. 

 

6.5.1 To activate property option card. 

Apart from directly clicking on the button, you may 

select the button for configuration from pull-down 

menu in page property option card. This menu 

comprises of all buttons in this page. If with too 

many buttons on the page, click on the button 

name for configuration, so as to activate the 

interface with ease, as the following picture: 

 

 

6.5.2 General 

It’s for configuring general properties. When a 

button is created, click on the button to activate it 

into property configuration column in General 

Option Card. In this column, all available button 

properties are listed. ThinkDraw software button 

has the following general property configuration  

interface: 

 

 
General property main interface of routine button. 

 

General property main interface of multi-states 

button. 

 

General property main interface of routine bar. 
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General property main interface of multi-states 

bar. 

 

Content description and application of General  

property configuration option card: 

Name: button name, a unique name for the button 

(e.g. 1,2,3,4 are more straightforward). Click on 

button default name. After activation, you may 

input new name and font with unlimited character 

numbers in this area. After that, click on the blank 

area to save it. 

 

Left/Top: configuring the left/top position in pixel 

unit, for configuring the detailed positioning 

information of button on page. Click on current 

positioning state of button, and then you may 

input the value to place the button at ideal 

position. 

Note: if you select the button and manually adjust 

it on any position of the page, the left/top value 

will also change accordingly showing current 

position. 

 

Width/height: configuring width/height value in 

pixel unit. You may edit these application 

information for making specific size. 

Note: if you select the button and manually adjust 

the width/height on page, the value of current size 

will be constantly updated. 

 

 

Jump Page: for configuring a button for directly 

jump to a specific page. Select a page for jumping 

from the pull-down menu. 

 

Lock: Configure auto lock status, click on the 

pull-down list to select “yes” or “no”. 

 

Inter Lock Group: When setting two or above 

buttons interlocked, press any button, always only 

one button state is triggered. 

 

State Count: for configuring the changing patterns 

of button. If 6 patterns are needed, please input 6. 

Note: this configuration is for using in multi-state 

button and multi-state bar only, as system default 

is 2 changing patterns. 

 

Amt Move Type: moving type, is for configuring 

the moving type of multi-states button. The 

system provides with 4 optional moving types. 

Click on the option to activate area configuration, 

and select your desired moving type from the 

pull-down menu. Note: this option is for 

multi-state button only. 

 

Value Direction: configure direction, set the bar in 

vertical or horizontal. This item is for configuring 

routine bar and multi-state bar 

 

6.5.3 Programming 

This item is for configuring programming property. 

Here lists the Join Number of button, you may 

configure on it. 
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Main configuration interface of button 

programming property  

    

6.5.4 States 

It’s for configuring states property. Once you 

create a new button, you may use this property 

option card to configure button state. The card 

lists property types of the selected button. In 

property control window, you may have 

configuration for properties of single button state 

and all buttons state. But some properties are 

only suitable for a certain button types, with the 

following descriptions:  

 

Property configuration main interface of routine 

button and bar states 

 

 

 

 

Main configuration interface of bar programming 

property 

 

 

Property configuration main interface of 

multi-state button and bar states 

 

Brief description of states property configuration 

option card: 

Draw Order: for configuring the sequence of 

layers for drawing. Click on navigation button to  

 

have a pop-up dialog box, with 5 layers available, 

they are: text, border, icon, fill, bitmap. Click on 

the layer for configuration. Press the “Move 

Down” or “Move Up” to adjust the layers for 

delivering ideal effect.  
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Border Name: If you’d like to change the pattern 

of selected button border, click on the border 

name, and then select your desired border name 

from the pull-down list. 

 

Border Color: to change the border color into 

ideal effect, click on the button to see a pop-up 

color dialog box. You may configure your color in 

it and customize color effect. For details, please 

refer to “Introduction to palette”.  

 

Fill Color: To change the filled-in color into your 

ideal effect, click on the button to see a color 

configuration dialog box. Please be noted that bar 

button is different when previewing image 

comparing to routine button and multi-state button, 

as bar button opens and closes state to indicate a 

level configuration. So all states are displayed in 

design view window in touch screen, but the 

thumbnail is displayed as a single preview image 

in State Manager window. If bar button is yellow 

when it’s on, red when it’s off, in State Manager 

window you will see both yellow and red colors 

will be displayed in the window separately.  

 

Text Color: it’s for changing text color. Click on the 

button to see color configuration dialog box, in 

which you may configure your color and 

customize color effect. 

 

Text Effect Color: if you select apply text effect, 

use it to configure your appointed color effect. 

Click on the navigation button “…” to open color 

dialog box. 

 

Bitmap: configure the background of button, click 

on image file navigation button “…” to open image  

 

selection dialog box, and then click on your 

desired image as background. For details, please 

refer to Button background image configuration. 

 

Bitmap Justification: to configure or reset  

 

background image position, click on pull-down 

menu at appointed bitmap (button needed for 

setting background image), select and adjust an 

option, the adjusted bitmap will be displayed on 

page in real time. 

 

Bitmap X and Y Offsets: If you need to position 

the bitmap, input the offset value of X or Y here, in 

pixel unit. 

 

Icon Slot: It’s for configuring button icon. You 

need to apply for an icon to configure the state. 

Click on navigation button to open resource 

dialog box, where you may select an icon to file 

an application. For details, please refer to Button 

image configuration. 

 

Icon Justification: to configure or reset the 

position of icon, click on pull-down menu at 

appointed bitmap (button needed for setting 

bitmap), select and adjust an option, the adjusted 

bitmap will be displayed on page in real time. 

 

Icon X and Y Offsets: If you need to position the 

bitmap, input the offset value of X or Y here, in 

pixel unit. 

 

Font: to change text font, click on navigation 

button to open text dialog box, where you may 

configure the font, pattern and size. 

 

Text: to change or input text for displayed on 

appointed button, input text in this area. If you 

need to input text in multiple lines, click on 

navigation button first, open dialog box, input new 

text or edit existing text. 

 

Text Justification: to configure or rest text position,  

 

click on pull-down menu at appointed bitmap 

(button need for setting text), select and adjust 

and option, the adjusted text will be displayed on 

page in real time. 
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Text X and Y Offsets: if you need to position the 

text, input the offset value of X or Y here, in pixel 

unit. 

 

Text Effect: the configuration of text effect in 

graphic can be applied in the text on button (for 

example: neon light effect suits for button. Each 

text effect is with several changes. i.e. small, 

middle, large or extra large). 

 

Word Wrap: For the reason that text character 

string is too long, text has to be cut into lines for 

placing onto a button, this item is for deciding 

whether to automatically change line, so as to 

adjust text line, making the text displayed 

compactly and clearly on button. Click on 

pull-down menu, and select “yes” or “no”. 

 

6.5.4.1 All button status 

Use all button status item to have configuration. It 

can control all button properties in one page, edit 

all buttons with listed properties. Click on the right 

side of the properties to activate it. According to 

different property choices, you may manually 

configure it, or make selection from pull-down 

menu. 

 

6.5.4.2 Configure button text 

1) Activate button property option card, click on 

“text” navigation button “…” in “States” property 

configuration. Text input dialog box appears as 

the following picture. Input your text in unlimited 

font and numbers. After that, press “OK” to exit.  

 

 

2) Click on “Font” navigation button “…” to have a 

pop-up text configuration dialog box, and then 

adjust the font, style and size. After that, press 

“confirm” to exit. The text on button will then 

display corresponding effect. 

 

 

3) If you need to adjust the text position in button, 

click on “Text Justification” pull-down menu, and 

you’ll have 10 options including absolute, top-left, 

top-middle, top-right, center-left, center-middle, 

center-right, bottom-left, bottom-middle and 

bottom-right. Your adjustment will be with 

real-time effect display, for ensuring you to have 

ideal effect.  

If the text position is not ideal, you may use “Text 

X and Y Offsets” option to have offset 

configuration for making best effect. 

 

4) If the text is too long, select “Word Wrap” 

option and then open text input box to have 

 

adjustment. The adjusted effect will constantly 

change correspondingly while you’re making 

selection.  

 

5) On “Text Effect,” click on navigation button “…” 

to visit text effect sub-menu. This sub-menu lists 

all available text effects of all types. Click on “+” 

icon to select your ideal effect. For example, if 

“Hard Drop Shadow 6” is selected, the text effect 

will be shown as following picture: 
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In property “Text Color” and “Text Effect Color,” 

you may adjust and customize text color. Click on 

navigation button “…” to open palette box. 

Directly select your desired color effect from color 

value. Press “OK” key to exit. You may use the 

eyedropper tool in palette to select your ideal 

color effect. Meanwhile, the color effect absorbed 

will be displayed in palette preview window. 

Confirm this color, and then click on eyedropper 

tool to exit selection. Click on “OK” key to save 

and exit. ( For details, please refer to Introduction 

to palette) 

 

 

Note: above operations of changing button text 

property has to be in good sequence when in 

actual operation, for quickly brining best design 

effect. 

 

 

 

6.5.4.3 Configure button image 

Add or change button image is a special item in 

States property, with the following approaches: 

1) select to button for adding or changing image. 

In states property option card, click on “Bitmap” 

navigation button “…” to open image selection 

dialog box, select image and then click on “OK” 

key to confirm. 

If there is no image to select from the dialog box, 

you may click on “Import” button to select the 

images saved in your computer. Press “open” to 

import it into the dialog box, select it and then 

click on “OK” key to exit.  

 

 

2) After selecting button image, click on the 

property of “Bitmap Justification,” and select 

relevant options from the pull-down menu for 

adjusting the image position (10 choices) on 

button. The states of button being adjusted will be 

displayed in real time. Click the blank to finish 

configuration. 

 

3) If it’s necessary to accurately position the 

image, please input X or Y offset value in “Bitmap 

X and Y Offsets” properties, in pixel unit. 

 

6.5.4.4 Configure button icon 

To add or change button icon is one of unique 

features in States property, use the following 

Select your 

image here 

Press this 

button to 

import image 
Confirm 

and exit 
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approaches to change the property: 

1) Click on property type “Icon Slot” navigation 

button “…” to open image selection dialog box, 

click on your desired image and click “OK” key to 

exit. The selected icon will be shown on the 

button. 

If there is no image in dialog box, you have to 

import an image into it and then select it. Click on 

tool bar button, from a pop-up dialog box, select 

an image to import, and the click on “Assign…” 

key. 

 

Slots dialog box will then be opened, click a 

position to place the image selected, click on 

“Assign” key again to place the image, open the 

dialog box. 

Return to States property option card, click on 

“Icon Slot” navigation button “…” to open image 

selection dialog box, click on your desired photo 

and press “OK” to exit. The select icon will be 

shown on the button. 

 

 

 

 

 

 

 

 

 

 

 

 

 

2) Click on “Icon Justification” property, from the 

pull-down menu, and select relevant options from 

the pull-down menu for adjusting the icon position 

(10 choices) on button. The states of button being 

adjusted will be displayed in real time. Click the 

blank to finish configuration. 

 

3) If it’s necessary to accurately position the 

image, please input X or Y offset value in “Icon X 

and Y Offsets” properties, in pixel unit. 

 

6.5.4.5 Configure button background color 

Use “Fill color” option to add or reset button 

background color. 

1) Click on “Fill Color” navigation button “…” to 

see palette dialog box; 

2) From color value, directly pick your desired 

color effect, press “OK” to exit, or you may use 

palette eyedropper tool to select your ideal color 

effect. Meanwhile, the absorbed color effect will 

be displayed in palette preview window. Confirm 

this color and click eyedropper tool to exit your 

selection, press “OK” key to save it and exit. (For 

detailed palette operation, please refer to 

Introduction to palette) 

 

6.5.4.6 Configure button border pattern 

1) Configure border pattern in property of “Border 

Name”. Click on “Border name” pull-down menu, 

in which there are many border patterns  

1,Click on this button on 

resource manager 

2,Select 

image 

3,Press this 

key to open 

next page 

Press 

this key 

to import 

image 

Select a 

position 

to place 

image 
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available. The selected pattern will be displayed 

on monitor in real time. 

Besides clicking on the items in the pull-down 

menu, you may activate this property and then 

directly press space bar to select it. After 

confirming the pattern, click on the blank. 

 

3) After configuring border pattern, click on 

“Border Color” navigation button “…” to access to 

palette dialog box, and then adjust border pattern 

color. Directly select you desired color effect from 

color value, press “OK” key to exit, or you may 

use palette eyedropper tool to select your ideal 

color effect. Meanwhile, the absorbed color effect 

will be displayed in palette preview window. 

Confirm this color and click eyedropper tool to exit 

your selection, press “OK” key to save it and exit. 

(For detailed palette operation, please refer to 

Introduction to palette) 

 

6.5.4.7 Introduction to states property 

States property is a configuration for multiple 

visual effects in button, with unlimited numbers 

and adjustable animation effect. It is configured 

as other approaches—using pull-down menu in 

property type or having manual input. Now we 

introduce the detailed configuration of states 

property. 

Please note that the main configuration window 

only displays the 1st state effect. The effects of 

other states will be displayed as thumbnails in 

“State Manager”. When making configuration, 

each state has to be configured one by one. 

Please note the state selected. 

 

Property of configuring states 

The properties of states includes State Count, 

Amt Move Type, in which multi-state bar is 

suitable for State Count property type. 

 

Configuring property of State Count  

Activate States property option card, click on 

“state count” from “general” property. System  

 

default number of states is 2. You may input your 

desired number of states in this area, and click on 

the blank. After configuration, you will find the 

thumbnail in “state manager” will display the 

number of states that you just configured.  

 

Configuring the property of Amt Move Type 

Amt Move type is the animation effect of state, 

selecting the button to be configured and the 

states to be changed. In this property, select your 

ideal animation effect from the pull-down menu. 

The system provides 5 animation types for you to 

choose. Click on the blank to finish configuration. 

 

Increase/decrease states 

To increase/decrease states can be done by 

configuring “stage count” property. When you 

input a quantity number of state, if it’s more than 

current number, it will be increased to your 

configured quantity number of states. If the state 

of increase is blank, correspondingly input a 

quantity number of state less than current quantity, 

it will be decreased to your configured quantity 

number of states. Correspondingly the state 

number will decrease progressively from the last 

value. If previous state number is 10, and now it 

needs to be cut to 8, then state 10 and state 9 will 

be deleted.  

 

Copy and paste button 

Copy and paste button can be used for any page 

or sub-page. You may copy one or multiple items. 

Please note when copying a button, all of its 

properties will be copied along. If a copied button 

is to be pasted to the same page, then the copied 

button will cover the original one. You need to 

drag it to see the effect.  
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Chapter 7 Download file to touch screen 
 

7.1 Download program 

To download the programmed file to touch screen, 

it must be ready with a complete touch screen 

(with battery installed correctly (not necessary), 

12V power, USB data cable, PC download 

program, which is with the following interface: 

 

1. Connect power cable correctly; 

 

2. Hold the “Home” key on touch screen (rounded 

at right top flank), restart touch screen (use thin 

hardware to press the right bottom hole), the 

touch screen will display “Update is Ready…”. 

When PC download software displays “date, 

System,” exit is for active state, stop is for not 

available, indicating the device is connected and 

ready for new system download. 

 

3. Press the “system” button in PC software, 

select the firmware (NK. Bin) for update, it will 

display “Update is started…,” until update is 

completed as it shows on touch screen.  

 

7.2 Update program 

To update the touch screen file downloaded, it 

must be ready with a complete touch screen (with 

battery installed correctly (not necessary), 12V 

power, USB data cable, PC download program 

(must be same as the download program, like the  

 

 

 

program interface in above picture). 

 

1. Connect power cable and data cable, restart 

the system. 

 

2. When “date, system” appears in PC download 

software interface, exit is for active state, stop is 

for not available, indicating the device is 

connected for data update. Click on “Date” button  

to select the date you wish to update. 

 

3. Update starts, the system jump to the following 

interface. 

 

 

Version is about the system version, File size is 

for the size of data file updating. Status is for 

current status. Progression bar is the percentage 

progressing.  

 

4. After updating, the program will automatically 

jump to control interface. 
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Chapter 8 Palette 
 

One of the biggest features of ThinkDraw is 

making most of a 32-bit RGB palette. An 

appointed RGB(red, green and blue) value, along 

with hue, saturation, brightness and 

non-transparent palette provide with millions of 

color effect, which can be used for transparent 

filling (page, pop-up page, button) and text (web 

page, pop-up page and button). 

 

You may save or customize palette, which can be 

saved as part of group files. Besides, it supports 

importing or saving Jasc® palette file, Microsoft® 

palette file or customized palette. 

 

8.1 Instruction to palette dialog 

box 

The color files saved in button and page color 

dialog box cannot be called until finishing in 

palette dialog box. User may customize color 

effect and save it for calling next time. You may 

delete or add color and adjust the color in palette, 

click on tool bar button to open palette dialog 

box , with the following interface:  

 

With the following description: 

New: click to create a blank palette, meanwhile 

relevant page and name will be shown in palette 

dialog box, you may configure your desired color 

 

effect. 

 

Copy: for copying palette file. Select the file to 

copy from palette pull-down menu, click on 

“Copy” key, “Paste” key is activated, and then 

click “Paste” key, the selected file will be copied 

and auto-named by the system as “******(2)”. At 

the same time, the color list is displayed. 

 

Rename: rename palette file, select the file to 

rename, click on “Rename” key to see a pop-up 

dialog box, input new file and click on “OK”. 

 

SetActive: activate renewal and create new file. If 

needed to call the updated or created file, you 

need to select the file at this item. Click on 

“SetActive” key to activate it. At the same time, 

these updated or new-created files can be used in 

palette dialog box.  

 

Import: to import the saved palette file. 

 

Export: to export the saved palette file for use in 

next time. 

 

View: palette color display mode, with “Details” 

and “Color Grid” available for you to choose. 

 

Copy Entry: In “Entries” area, click on the entry to 

copy, press “Copy Entry,” and then “Paste Entry” 

key is activated. Choose a position to place the 

entry, and then press “Paste Entry” key to 

confirm. 

 

Paste Entry: In “Entries” area, click on the entry to 

copy, press “Copy Entry,” and then “Paste Entry” 

key is activated Choose a position to place the 

entry, and then press “Paste Entry” key to 

confirm. 
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Clear Entry: for deleting entry. In “Entries” area, 

select the entry to clear, and then leaving a blank 

entry. 

 

Index: display the serial number of current color 

entry. This item is not for editing. 

 

Name: display the name of current color entry, 

meanwhile you may modify or add the name of  

color entry. 

 

Palette dialog box supports 3 ways of color 

selection: 

 

1. RGB color: a RGB palette with full function, 

providing appointed RGB(hue, saturation, 

brightness and opacity)value, or you may drag 

cursor pick color from the palette. This RGB 

palette provides millions color. 

 

2. Palette index: default palette provides 

corresponding 88 colors (for modifying if 

necessary). Palette index provides with up to 255 

colors. 

 

3. Color name: based on the 88 colors in color 

selection dialog box, input color name and make 

selection (including transparent color). 

When configuring RGB palette, the color you pick 

sometimes could be with a little change. In most 

cases, any change is delicate, as ThinkDraw 

entirely match the colors. 

 

Transparent background configuration 

After creating a button icon, if you’d like to take 

advantage of the features of ThinkDraw, usually 

you may take transparent bitmap as background 

for fitting the layers of bitmap, but not trying to 

match the trans-layer color, for example: picture 1 

is the button with non-transparent background 

color, while picture 2 the button with transparent 

background color. Apparently, you’ll choose the 

button with transparent background, as it keeps 

 

the original rectangular shape. ThinkDraw 

supports png format. 

      

Picture 1                Picture 2 

 

8.1.1  States 

To create a new color, configure it in “Color Value” 

area in palette dialog box. 

 

1) Select file storage position in “Entries” area, 

and then move the cursor to “Color Value” area to 

configure. 

 

2) You may adjust Hue, Sat, Bright, Red, Green, 

Blue, Opacity and Hex values, or you may move 

your cursor on color value to directly pick up your 

ideal color. 

 

3) The color you pick will be shown in preview box. 

Press “Commit” key to confirm it, meanwhile, the 

color entries will be shown at pre-picked storage 

position. 

 

4) After confirming the color entries, edit the name 

at “Name” item. 

With the following operations: 
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8.2.1 Create self-customized palette 

There are plenty of colors applied in each page 

and button. For the convenience of management 

and future modification, it is very important to 

create a set of files and a palette. 

1） Open palette dialog box, system default is 
displaying current palette in use. 

2） Click “New” key to directly create a new 
palette, meanwhile the system will automatically 

generate a file name. 

3） Click “Rename” key to see a pop-up dialog 
box, you may rename it for the convenience of 

management. It is advised to share the same 

name of subject title. 

 

8.2.3 Import palette file 

To import and call file saved in PC, click on 

“Import” key on palette interface, find the file and 

press “Open” to import it. Meanwhile, you can see 

corresponding display in palette interface. Press 

“SetActive” key to activate it. 

After importing the file, open palette dialog box in  

 

property setup, as seen in the picture, select 

“Palette Index” and see imported color file in the 

interface. 

 

 

8.2.4 Export palette file 

To export the configured palette and select the file 

to save, click “Export” key to open saving 

directory, select a path to save it.  

1,Choose 

storage 

position 

The picked 

color will 

be stored 

here 

 

2,Directly 

pick it by 

cursor 

 

3,Also you 

may adjust 

value here 

 

The picked 

color will be 

shown here 

 

Name 

editing 

 e 

Confirm 
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